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Administratorhandbuch

Die folgenden Anweisungen gelten für Administratoren an Standorten mit dem Lizenztyp Lizenz für
gleichzeitig angemeldete Benutzer für IBM® SPSS Modeler 18.1.1. Mit dieser Lizenz können Sie IBM
SPSS Modeler auf beliebig vielen Computern installieren. Allerdings hängt die Anzahl der Benutzer, die
die Anwendung gleichzeitig ausführen können, davon ab, für wie viele Personen die Lizenz erworben
wurde.

Vorbereitungen
Sie benötigen Ihren Autorisierungscode. Mit dem Autorisierungscode können Sie eine Lizenz für den
Concurrent License Manager abrufen. Der Concurrent License Manager steuert die Lizenz für gleichzei-
tig angemeldete Benutzer und ermöglicht den Endbenutzern die Ausführung von IBM SPSS Modeler.

Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscodes erhalten haben. Wenn Sie den
Autorisierungscode nicht finden können, wenden Sie sich an den Kundendienst. Rufen Sie hierzu die Sei-
te http://www.ibm.com/software/analytics/spss/support/clientcare.html auf.

Führen Sie die folgenden Schritte aus, um sicherzustellen, dass Sie die Lizenz für gleichzeitig angemelde-
te Benutzer ordnungsgemäß eingerichtet haben:
1. Installieren Sie den Concurrent License Manager. Der Concurrent License Manager ist ein Dienst-

programm, das Endbenutzern die Lizenz für gleichzeitig angemeldete Benutzer bereitstellt. Sie können
den Lizenzmanager auf einem beliebigen Computer in Ihrem Netz speichern. Üblicherweise handelt
es sich dabei um einen Server, an den Desktop-Computer angeschlossen werden können. Weitere In-
formationen finden Sie in „Installieren von Concurrent License Manager” auf Seite 2.

2. Lizenzieren Sie das Produkt. Mit diesem Vorgang erhält der Lizenzmanager die für die Ausgabe der
Lizenzen erforderlichen Informationen.

3. Testen Sie den Concurrent License Manager. Sie sollten den Lizenzmanager testen, um sicherzustel-
len, dass er Lizenzen bereitstellt. Weitere Informationen finden Sie in „Testen des Lizenzmanagers”
auf Seite 7.

4. Installieren Sie IBM SPSS Modeler auf den lokalen Desktop-Computern. Sie oder Ihre Endbenut-
zer führen die vollständige Installation auf den Desktop-Computern durch. Während der Installation
kann der Endbenutzer den Computer angeben, auf dem der Lizenzmanager ausgeführt wird. Wenn
ein Endbenutzer versucht, IBM SPSS Modeler zu starten, fordert das Produkt bei diesem Lizenzmana-
ger einen Lizenzcode an. Wenn eine Lizenz verfügbar ist, wird IBM SPSS Modeler gestartet. Weitere
Informationen finden Sie in „Installieren des Produkts auf lokalen Desktop-Computern” auf Seite 8.

Für die Installation sind keine administrativen Schritte erforderlich. Sollten jedoch Probleme auftreten,
finden Sie in „Verwalten der Lizenz für gleichzeitig angemeldete Benutzer” auf Seite 10 weitere Informa-
tionen.

Citrix- und Terminaldienste
Sie können die Anwendung IBM SPSS Modeler auf dieselbe Art auf dem Citrix- bzw. Terminaldienst-Ser-
ver installieren und den Benutzern zugänglich machen, auf die Sie andere Anwendungen für Windows
installieren und zugänglich machen.

Gemischte Lizenzierung
IBM SPSS Modeler unterstützt gemischte Lizenzierungsumgebungen (eine Kombination aus lokalen Li-
zenzen für berechtigte Benutzer und Lizenzen für gleichzeitig angemeldete Benutzer) nur in einge-
schränktem Maße. In einer typischen Umgebung werden sämtliche Lizenzen entweder lokal oder über
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den Concurrent License Manager verwaltet. Wenn das Hauptprodukt beispielsweise über den Concurrent
License Manager lizenziert ist, werden Optionen ebenfalls über den Concurrent License Manager lizen-
ziert.

Eine gemischte Lizenzierung ist nur möglich, wenn das Hauptprodukt über den Concurrent License Ma-
nager lizenziert und die Optionen auf dem Computer des Endbenutzers mit licenseactivator lizenziert wer-
den. Installieren Sie IBM SPSS Modeler mit einer Lizenz für gleichzeitig angemeldete Benutzer, um diese
Art der gemischten Lizenzierung einzurichten. Verwenden Sie dann licenseactivator auf dem Computer
des Endbenutzers, um die Optionen zu lizenzieren. Weitere Informationen zu licenseactivator finden Sie in
„Verwenden von licenseactivator zur automatischen Installation einer Lizenz” auf Seite 6.

IBM SPSS Modeler unterstützt das umgekehrte Szenario nicht, bei dem das Hauptprodukt lokal und die
Optionen über den Concurrent License Manager lizenziert werden.

Installieren von Concurrent License Manager
Bevor Endbenutzer IBM SPSS Modeler auf ihrem Desktop-Computer installieren, müssen Sie den Concur-
rent License Manager installieren. Dieses Dienstprogramm ist ein fortlaufend ausgeführter Service oder
Dämonprozess, der üblicherweise auf einem Computer im Netz installiert wird. (Sie haben auch die Mög-
lichkeit, ihn auf mehreren Computern zu installieren, wobei Sie redundante Lizenzmanager einrichten
müssen. Weitere Informationen finden Sie in „Einrichten von redundanten Lizenzservern” auf Seite 12.)
Der Concurrent License Manager wird nicht auf den Desktop-Computern der Endbenutzer installiert.

Immer wenn ein Endbenutzer eine der Lizenz für gleichzeitig angemeldete Benutzer unterliegende IBM
SPSS-Anwendung startet, fordert die Anwendung eine Lizenz vom Lizenzmanager an. Dieses Dienstpro-
gramm gibt Lizenzen bis zu einer festgelegten Anzahl gleichzeitiger Endbenutzer aus, die sich aus der
von Ihnen erworbenen Lizenz ergibt. Wenn diese Anzahl erreicht ist, werden weitere Anfragen nach Li-
zenzen zurückgewiesen. Wenn Sie feststellen, dass Endbenutzern häufig Lizenzen verweigert werden, er-
kundigen Sie sich bei dem für Sie zuständigen Händler nach einer Lizenz für eine größerer Anzahl
gleichzeitiger Benutzer.

Anmerkung: Der Lizenzmanager zeichnet die Anzahl aktiver Endbenutzersitzungen sowie Informationen
zu diesen einzelnen Sitzungen in einer Protokolldatei auf, die Sie dann zur Fehlerbehebung bei Verbin-
dungsproblemen heranziehen können. Weitere Informationen finden Sie in „Abrufen von
Protokollinformationen” auf Seite 11.

Mehrere Betriebssysteme

Die Plattform, auf der der Concurrent License Manager ausgeführt wird, muss nicht mit der Plattform
übereinstimmen, auf der der Client aktiv ist. Zum Beispiel kann ein Linux-Lizenzmanager Lizenzen für
Windows-Clients bereitstellen.

Verwalten des Lizenzmanagers

Der Lizenzmanager wird mithilfe des Lizenzmanageradministrators verwaltet, der nur für Windows ver-
fügbar ist. Beachten Sie deshalb, dass Sie mindestens einen Windows-System benötigen, auf dem der Li-
zenzmanageradministrator installiert ist.

Systemanforderungen

Der Computer, auf dem der Concurrent License Manager installiert werden soll, muss folgende Anforde-
rungen erfüllen. Für den Lizenzmanager ist kein Serverklassencomputer erforderlich.
v Prozessor mit mindestens 550 Mhz
v Mindestens 128 MB RAM
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Wichtig: Wenn auf dem Computer, auf dem der Lizenzmanager installiert ist, eine Firewall aktiv ist,
müssen Sie Port 5093 für UDP öffnen. Andernfalls können die Client-Computer keine Lizenz vom Lizenz-
manager abrufen. Wenn Sie darüber hinaus redundante Lizenzmanagercomputer verwenden, müssen Sie
Port 5099 für UDP öffnen, damit die Lizenzmanagercomputer untereinander kommunizieren können.

Durchführen eines Upgrades für den Lizenzmanager
Wenn Sie eine frühere Version des Lizenzmanagers installiert haben, müssen Sie die folgenden Schritte
durchführen:
1. Wechseln Sie in das Verzeichnis, in dem Sie den alten Lizenzmanager installiert haben.
2. Kopieren Sie die Datei lservrc. Windows: Suchen Sie im Verzeichnis winnt.
3. Speichern Sie die Datei lservrc an einer sicheren Position.
4. Falls Benutzer Pendlerlizenzen ausgecheckt haben, stellen Sie sicher, dass diese Lizenzen wieder ein-

gecheckt werden. Informationen zum Abrufen einer Liste der ausgecheckten Lizenzen finden Sie in
„Konfigurieren von Pendlerlizenzen” auf Seite 13.

5. Fahren Sie den Lizenzmanager herunter. Weitere Informationen finden Sie in „Starten und Stoppen
des Lizenzmanagers” auf Seite 16.

6. Deinstallieren Sie den alten Lizenzmanager. Weitere Informationen finden Sie in „Deinstallieren des
Lizenzmanagers” auf Seite 16.

7. Installieren Sie den neuen Lizenzmanager. Informationen zum Installieren unter Windows finden Sie
in „Installieren des Lizenzmanagers unter Windows”. Informationen zum Installieren unter UNIX/
Linux finden Sie in „Installieren des Lizenzmanagers unter anderen Betriebssystemen als Windows”
auf Seite 4.

8. Kopieren Sie die gespeicherte Datei lservrc in das Verzeichnis, in dem Sie den neuen Lizenzmanager
oder das Unterverzeichnis winnt des Installationsverzeichnisses unter Windows installiert haben.
Wenn Sie die Standardposition unter Windows akzeptiert haben, prüfen Sie den Ordner C:\Programme
(x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager\WinNT.

Installieren des Lizenzmanagers unter Windows

Anmerkung: Sie müssen das Installationsprogramm als Administrator starten. Wenn Sie aufgefordert
werden, eine Installationsdatei zu starten, klicken Sie mit der rechten Maustaste auf die Datei und wählen
Sie Als Administrator ausführen aus.

Anmerkung: Vergewissern Sie sich, dass auf dem Computer, auf dem Sie die Installation durchführen,
Java installiert ist.
1. Verwenden Sie für die heruntergeladene e-Image-Datei ein Archivierungsdienstprogramm wie Win-

Zip, um alle Dateien im entsprechendem eImage zu extrahieren.
2. Extrahieren Sie den Inhalt des Archivs mit dem Lizenzmanager und den Tools.
3. Führen Sie setup.exe im extrahierten Verzeichnis manager aus und befolgen Sie die auf dem Bild-

schirm angezeigten Anweisungen.
4. Führen Sie setup.exe im extrahierten Verzeichnis tools aus und befolgen Sie die auf dem Bildschirm

angezeigten Anweisungen, um den Lizenzmanageradministrator auf demselben Computer wie den
Lizenzmanager zu installieren. Sie können den Lizenzmanageradministrator auch auf einem anderen
Windows-System installieren, wenn Sie den Lizenzmanager remote verwalten möchten.

Installieren des Lizenzmanagers unter Mac OS
1. Legen Sie die DVD mit den parallelen Lizenzierungstools in das DVD-Laufwerk des Netzcomputers

ein, auf dem der Lizenzmanager ausgeführt werden soll. Suchen Sie das Archiv mit dem Lizenzmana-
ger und den Tools für Ihr Betriebssystem.
ODER:
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Wenn Sie eine eImage-Datei heruntergeladen haben, wechseln Sie zu der Position, an der Sie die Datei
heruntergeladen haben.

2. Extrahieren Sie das Archiv mit dem Lizenzmanager und den Tools an der Position, an der Sie den Li-
zenzmanager installieren wollen.

3. Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen
finden Sie in „Installieren des Lizenzmanageradministrators”.

4. Weitere Informationen zum Starten des Lizenzmanagers finden Sie in „Starten und Stoppen des
Lizenzmanagers” auf Seite 16.

Installieren des Lizenzmanagers unter anderen Betriebssystemen als
Windows
1. Wechseln Sie zu der Position, an der Sie die eImage-Datei heruntergeladen haben.
2. Extrahieren Sie das Archiv mit dem Lizenzmanager und den Tools an der Position, an der Sie den Li-

zenzmanager installieren wollen.
3. Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen

finden Sie in „Installieren des Lizenzmanageradministrators”.
4. Weitere Informationen zum Starten des Lizenzmanagers finden Sie in „Starten und Stoppen des

Lizenzmanagers” auf Seite 16.

Installieren des Lizenzmanageradministrators
Der nur für Windows verfügbare Lizenzmanageradministrator wird für die Verwaltung des Lizenzmana-
gers verwendet. Wenn Sie den Lizenzmanager auf einem Nicht-Windows-System installiert haben, müs-
sen Sie den Lizenzmanageradministrator auf einem Windows-System installieren.
1. Verwenden Sie für die heruntergeladene e-Image-Datei ein Archivierungsdienstprogramm wie Win-

Zip, um alle Dateien im entsprechendem eImage zu extrahieren.
2. Extrahieren Sie den Inhalt des Archivs mit dem Lizenzmanager und den Tools.
3. Führen Sie setup.exe im extrahierten Verzeichnis tools aus und befolgen Sie die auf dem Bildschirm

angezeigten Anweisungen.

Produktlizenzierung
Bei anderen Betriebssystemen als Windows müssen Sie die Lizenz nach der Installation des Lizenzmana-
gers über die Eingabeaufforderung installieren.

Anmerkung: Lizenzen sind mit einem Sperrcode an die physische oder virtuelle Hardware des
Netzcomputers gebunden. Wenn Sie den Netzcomputer oder die zugehörige Hardware austauschen, be-
nötigen Sie einen neuen Sperrcode und müssen bei Ihrem Vertriebsbeauftragten einen neuen Autorisie-
rungscode anfordern. Bei Installationen auf einer virtuellen Maschine müssen Sie sicherstellen, dass Sie
einen Sperrcode auswählen, der sich beim Neustart nicht ändert. Weitere Informationen finden Sie in „In-
stallieren einer Lizenz in einer virtuellen Umgebung”.

Wichtig: Die Lizenz reagiert auf Änderungen der Systemzeit. Wenn Sie die Systemzeit ändern müssen
und dann das Produkt nicht mehr ausführen können, fordern Sie Unterstützung durch das Kunden-
betreuungsteam über die Seite http://www.ibm.com/software/analytics/spss/support/clientcare.html
an.

Installieren einer Lizenz in einer virtuellen Umgebung
Es gibt spezielle Lizenzierungsanweisungen für Installationen des Concurrent License Managers in einer
virtuellen Umgebung. Bei einer virtuellen Maschine ist die Hardware virtuell und der Sperrcode, mit dem
der Lizenzmanager an die Lizenz gebunden ist, kann sich beim Neustart der virtuellen Maschine ändern.
Sie müssen einen Sperrcode finden, der sich beim Neustart der virtuellen Maschine nicht ändert, um si-
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cherzustellen, dass der Lizenzmanager ordnungsgemäß funktioniert. Wenn Sie einen stabilen Sperrcode
finden, verwenden Sie ihn für die Lizenzierung des Lizenzmanagers.

Wichtig:

Wenn Sie einen Sperrcode auswählen, der sich beim Neustart ändert, funktioniert der Lizenzmanager
nicht mehr. Die IBM SPSS-Anwendung kann keine Lizenz abrufen und daher nicht gestartet werden.

Prüfen des Sperrcodes
1. Öffnen Sie eine Eingabeaufforderung.
2. Wechseln Sie in das folgende Verzeichnis.
v Windows. Das Installationsverzeichnis für den Lizenzmanageradministrator. Wenn Sie während der

Installation die Standardposition akzeptiert haben, lautet das Installationsverzeichnis für den Li-
zenzmanageradministrator C:\Programme (x86)\IBM\SPSS License Tools\9.7.0.0.

v Andere Plattformen. Das Installationsverzeichnis für den Lizenzmanager.
3. Geben Sie an der Eingabeaufforderung echoid (Windows) oder ./echoid (andere Plattformen) ein.

Es wird eine Ausgabe ähnlich der folgenden angezeigt:

Locking Code 1 : 4-12A1B

Die unmittelbar vor dem Bindestrich (-) angezeigte Zahl ist das Sperrcodekriterium. Das Sperrcodekriteri-
um ist eine Zahl, die die virtuelle Hardware darstellt, die für den Sperrcode verwendet wird (in diesem
Beispiel ist dies 4 und stellt die Datensatz-ID des Datenträgers mit dem Betriebssystem dar). Die Zahl
hinter dem Bindestrich ist der Sperrcode (in diesem Beispiel ist dies 12A1B).

Mögliche Sperrcodekriterien:

Sperrcodekriterium Virtuelle Hardware

2 IP-Adresse

4 Datensatz-ID des Datenträgers mit dem Betriebssystem

8 Hostname

10 Ethernet-Karte

Prüfen, ob der Sperrcode stabil ist
1. Starten Sie die virtuelle Maschine nach der Prüfung des Sperrcodes neu.
2. Prüfen Sie den Sperrcode erneut (siehe „Prüfen des Sperrcodes”).
v Wenn sich der Sperrcode nicht ändert, führen Sie einen Warmstart durch und prüfen Sie den Sperr-

code mehrmals. Wenn der Sperrcode stabil ist, können Sie die Lizenzierung durchführen (siehe „Li-
zenzierung des Lizenzmanagers mit dem neuen Sperrcode” auf Seite 6).

v Wenn sich der Sperrcode ändert, müssen Sie ihn aktualisieren (siehe „Aktualisierung des Sperr-
codes”).

Aktualisierung des Sperrcodes
1. Öffnen Sie die Datei echoid.dat, die sich im folgenden Verzeichnis befindet, in einem Texteditor.
v Windows. Das Installationsverzeichnis für den Lizenzmanageradministrator. Wenn Sie während der

Installation die Standardposition akzeptiert haben, lautet das Installationsverzeichnis für den Li-
zenzmanageradministrator C:\Programme (x86)\IBM\SPSS License Tools\9.7.0.0.

v Andere Plattformen. Das Installationsverzeichnis für den Lizenzmanager.
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2. Es wird eine Hexadezimalzahl angezeigt, die das aktuelle Sperrcodekriterium darstellt. Ändern Sie
diese Zahl in ein zulässiges Sperrcodekriterium im Hexadezimalformat.

Sperrcodekriterium im Hexadezimalformat Virtuelle Hardware

0x002 IP-Adresse

0x004 Datensatz-ID des Datenträgers mit dem Betriebssystem

0x008 Hostname

0x010 Ethernet-Karte

Lizenzierung des Lizenzmanagers mit dem neuen Sperrcode

Wenn Sie einen stabilen Sperrcode gefunden und eine entsprechende Aktualisierung durchgeführt haben,
gibt es keine weiteren spezifischen Lizenzierungsschritte für virtuelle Umgebungen. Beenden Sie die Ins-
tallation der Lizenz über die Eingabeaufforderung.

Installieren einer Lizenz über die Eingabeaufforderung

Sie haben zwei Möglichkeiten zur Installation über die Eingabeaufforderung. Sie können mithilfe von li-
censeactivator automatisch eine Lizenz aus dem Internet abrufen oder Sie können mithilfe von echoid
manuell eine Lizenz beziehen.

Anmerkung: Wenn Sie für redundante Lizenzserver eine unbeaufsichtigte Installation durchführen, müs-
sen Sie den Computer nach Abschluss der Installation neu starten.

Verwenden von licenseactivator zur automatischen Installation einer Lizenz
Der Computer, auf dem Sie die Lizenz installieren, muss mit dem Internet verbunden sein. Andernfalls
müssen Sie die Lizenz manuell installieren. Weitere Informationen finden Sie in „Manuelles Installieren
einer Lizenz” auf Seite 7.
1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.
2. Öffnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-

nageradministrators. Dies ist das Verzeichnis, in dem Sie den Lizenzmanageradministrator installiert ha-
ben, nicht das Installationsverzeichnis von IBM SPSS Modeler. Wenn Sie die Standardposition unter
Windows akzeptiert haben, prüfen Sie den Ordner C:\Programme (x86)\IBM\SPSS License Tools\
9.7.0.0.

3. Normalerweise sind Sie im Besitz eines Autorisierungscodes. Im einfachsten Fall geben Sie an der Ein-
gabeaufforderung Folgendes ein. (Weitere Details zur Verwendung der Befehlszeile finden Sie unten.)
licenseactivator <Autorisierungscode>

Dabei ist <Autorisierungscode> Ihr Autorisierungscode.

Es sollte eine Nachricht angezeigt werden, dass die Lizenz erfolgreich hinzugefügt wurde. Andernfalls
notieren Sie sich den Fehlercode und versuchen Sie, die Lizenz manuell zu installieren. Weitere Informati-
onen finden Sie in „Manuelles Installieren einer Lizenz” auf Seite 7.

Bei Verwendung von licenseactivator wird das Produkt lizenziert und eine Protokolldatei wird in das Pro-
duktverzeichnis geschrieben. Der Name der Protokolldatei ist licenseactivator_<Monat>_<Tag>_<Jahr>.log.
Wenn Fehler auftreten, können Sie gegebenenfalls der Protokolldatei weitere Informationen entnehmen.
Diese Informationen sind auch dann hilfreich, wenn Sie sich an den IBM Support wenden.

Verwenden von licenseactivator mit Autorisierungscodes

licenseactivator wird üblicherweise mit einem oder mehreren Autorisierungscodes verwendet, die Sie beim
Kauf des Produkts erhalten haben. Geben Sie den gesamten Text in einer einzigen Zeile ein.
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licenseactivator Autorisierungscode1[:Autorisierungscode2:...:AutorisierungscodeN] [PROXYHOST=Proxy-Hostname]
[PROXYPORT=Proxy-Portnummer] [PROXYUSER=Proxy-Benutzer-ID] [PROXYPASS=Proxy-Kennwort]

v Mehrere Autorisierungscodes werden durch Doppelpunkte (:) getrennt.
v Die Proxy-Einstellungen sind optional, aber sie sind unter Umständen nötig, wenn sich Ihr Computer

hinter einem Proxy befindet. Welche Proxy-Einstellungen benötigt werden, hängt von der jeweiligen
Proxy-Konfiguration ab. Möglicherweise sind alle erforderlich.

PROXYHOST
Der Servername oder die IP-Adresse des Proxy-Hosts

PROXYPORT
Die Portnummer für die Internetverbindung über den Proxy

PROXYUSER
Falls erforderlich, die Benutzer-ID für den Proxy

PROXYPASS
Falls erforderlich, das Kennwort für die Benutzer-ID

Verwenden von licenseactivator mit Lizenzcodes

Eventuell hat Ihnen IBM eine Lizenz gesendet.
licenseactivator Lizenzcode[:Lizenzcode2:...:LizenzcodeN]

v Mehrere Lizenzcodes werden durch Doppelpunkte (:) getrennt.
v Bei Verwendung von Lizenzcodes stellt licenseactivator keine Verbindung zum Internet her, sodass Sie

keine Proxy-Informationen angeben müssen.

Manuelles Installieren einer Lizenz
1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.
2. Öffnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-

nageradministrators. Beachten Sie, dass dies der Ordner ist, in dem Sie den Lizenzmanageradministrator
installiert haben, nicht das Installationsverzeichnis von IBM SPSS Modeler. Wenn Sie die Standardpo-
sition unter Windows akzeptiert haben, prüfen Sie den Ordner C:\Programme (x86)\IBM\SPSS License
Tools\9.7.0.0.

3. Rufen Sie den Sperrcode für den Server-Computer ab. Geben Sie an der Eingabeaufforderung echoid
(Windows) oder ./echoid (andere Plattformen) ein.

4. Rufen Sie unsere regionale Niederlassung an oder senden Sie eine E-Mail an spsscs@us.ibm.com und
teilen Sie IBM den Sperrcode und Ihren Autorisierungscode mit. IBM wird Ihnen anschließend einen
Lizenzcode oder eine Datei mit dem Lizenzcode bereitstellen.

5. Verwenden Sie licenseactivator zur Eingabe des bzw. der Lizenzcodes.

Hinzufügen einer Lizenz
Eventuell möchten Sie zu einem späteren Zeitpunkt eine Lizenz hinzufügen. Der Vorgang beim Hinzufü-
gen einer Lizenz ist identisch mit der Installation der originalen Lizenz.

Anzeigen der Lizenz
Sie können Ihre Lizenz für gleichzeitig angemeldete Benutzer (einschließlich der Anzahl der Benutzer) in
der Anwendung WlmAdmin anzeigen. Informationen zur Anwendung WlmAdmin und die Besonderhei-
ten beim Anzeigen der Lizenz finden Sie in „Verwalten der Lizenz für gleichzeitig angemeldete Benutzer”
auf Seite 10.

Testen des Lizenzmanagers
Um sicherzustellen, dass der Lizenzmanager die Lizenzen korrekt bereitstellt, sollten Sie ihn testen.
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1. Wenn Sie den Lizenzmanageradministrator nicht auf einem anderen System installiert haben, installie-
ren Sie ihn auf einem Windows-System, auf dem der Lizenzmanager, den Sie testen möchten, nicht
läuft. Weitere Informationen finden Sie in „Installieren des Lizenzmanageradministrators” auf Seite 4.

2. Installieren Sie einen weiteren Lizenzmanager auf einem Windows-System, auf dem der Lizenzmana-
ger, den Sie testen möchten, nicht ausgeführt wird. Weitere Informationen finden Sie in „Installieren
des Lizenzmanagers unter Windows” auf Seite 3.

3. Starten Sie die Anwendung WlmAdmin. Weitere Informationen finden Sie in „Starten der Anwendung
WlmAdmin” auf Seite 10.

4. Fügen Sie den fernen Server des Lizenzmanagers hinzu, den Sie testen möchten. Weitere Informatio-
nen finden Sie in „Hinzufügen eines Servers” auf Seite 11.

5. Zeigen Sie die Lizenzen auf dem fernen Server an. Weitere Informationen finden Sie in „Anzeigen der
Details zu einer Lizenz” auf Seite 11.

Wenn Sie die Lizenzen anzeigen können, ist der Lizenzmanager bereit und lokale Desktop-Computer
können angeschlossen werden. Sie können mit der Installation des Produkts auf lokalen Desktop-Compu-
tern beginnen. Wenn Sie die Lizenzen nicht anzeigen können, überprüfen Sie die vorhergehenden Schrit-
te, um sicherzustellen, dass der Lizenzmanager korrekt installiert wurde.

Installieren des Produkts auf lokalen Desktop-Computern

Anmerkung: Die Verbindung mit dem Concurrent License Manager über VPN wird nicht offiziell unter-
stützt.

Für die lokale Installation des vollständigen Produkts auf den Computern der Endbenutzer stehen Ihnen
zwei Optionen zur Verfügung: Sie können auf jedem Computer eine manuelle Installation durchführen
oder eine Anwendung wie Systems Management Server (SMS) verwenden, um die Installation auf Win-
dows-Computern durchzuführen.

Durchführen einer manuellen Installation auf einem lokalen Desktop-Computer
1. Stellen Sie die Installationsmedien zur Verfügung. Laden Sie das eImage für das Produkt herunter

und extrahieren Sie die Dateien auf einem freigegebenen Netzlaufwerk.
2. Kopieren Sie die Installationsanweisungen und bereiten Sie die Lizenzinformationen vor. Erstellen

Sie die benötigte Anzahl von Kopien der Installationsanweisungen für das Produkt. Die Installations-
anweisungen stehen auf der Download-Site zur Verfügung. Suchen Sie nach den Anweisungen, die
Ihrem Lizenztyp entsprechen. Nach der Installation müssen die Endbenutzer die IP-Adresse oder den
Namen des Netzcomputers eingeben, auf dem der Concurrent License Manager ausgeführt wird. Tra-
gen Sie diese Informationen an der dafür vorgesehenen Stelle am Anfang der Anweisungen ein, bevor
Sie diese kopieren.

3. Verteilen Sie die Installationsunterlagen und -medien an die Endbenutzer. Verteilen Sie die herun-
tergeladene Datei (bzw. geben Sie die Netzadresse des Installationsdatenträgers bekannt), die Installa-
tionsanweisungen und die Lizenzinformationen an die Endbenutzer, die auf den Computern nach Be-
darf manuell installieren können.

Übertragen der Installation unter Windows auf lokale Desktop-Computer

Da IBM SPSS Modeler-Installationen mit Microsoft Windows Installer (MSI) kompatibel sind, können Sie
die Installation automatisch auf die Desktop-Computer der Endbenutzer übertragen.

Übertragen einer Installation auf Windows-Computer
Das Übertragen einer Installation ist eine Methode für die Fernverteilung von Software an eine beliebige
Zahl von Endbenutzern, ohne dass die Benutzer aktiv werden müssen. Sie können eine vollständige Ins-

8 IBM SPSS Modeler Lizenz für gleichzeitig angemeldete Benutzer - Administratorhandbuch



tallation von IBM SPSS Modeler auf die Computer der Endbenutzer unter Windows übertragen. Die für
die automatische Übertragung der Installation verwendete Technologie muss die MSI 3.0-Engine oder hö-
her unterstützen.

Deinstallation einer früheren Version
Wenn Sie die automatische Übertragung in ein Verzeichnis durchführen, in dem eine frühere Version von
IBM SPSS Modeler installiert wurde, muss die alte Version deinstalliert werden. Sie müssen IBM SPSS
Modeler-Versionen vor 11.0 manuell entfernen, da Push-Installationen für diese Versionen nicht verfügbar
waren. Sie können die Deinstallation ebenso wie eine Installation übertragen. Weitere Informationen fin-
den Sie in „Automatische Übertragung einer Deinstallation” auf Seite 10.

Eigenschaften für automatisch übertragene Installationen
Nachfolgend finden Sie die Eigenschaften, die für automatisch übertragene Installationen verwendet wer-
den können. Bei allen Eigenschaften wird zwischen Groß- und Kleinschreibung unterschieden. Werte
müssen in Anführungszeichen angegeben werden, wenn sie Leerzeichen enthalten.

Tabelle 1. Eigenschaften für automatisch übertragene Installationen.

Eigenschaft Beschreibung Gültige Werte Standardwert (falls zutref-
fend)

INSTALLDIR Das Verzeichnis, in dem
IBM SPSS Modeler auf dem
Desktop-Computer des
Endbenutzers installiert
werden sollte. Diese Eigen-
schaft ist optional. Wird sie
nicht angegeben, wird der
Standardwert C:\
Programme\IBM\SPSS\
Modeler\18.1.1 verwendet.

Ein gültiger Pfad, beispiels-
weise C:\Programme\
IBM\SPSS\Modeler\18.1.1.

C:\Programme\IBM\SPSS\
Modeler\18.1.1

LICENSETYPE Der Lizenztyp. Bei diesem
Wert wird zwischen Groß-
und Kleinschreibung unter-
schieden.

Network

LSHOST Die IP-Adresse oder der
Name des Computers bzw.
der Computer im Netz, auf
dem bzw. denen der
Concurrent License Mana-
ger ausgeführt wird.

Eine oder mehrere gültige
IP-Adressen oder Namen
der Computer im Netz.
Mehrere Adressen oder Na-
men werden durch Tilden
getrennt (z. B.
Server1~Server2~Server3).

MSI-Dateien
Extrahieren Sie den Inhalt des heruntergeladenen eImage, um auf die MSI-Datei zugreifen zu können. Die
Datei befindet sich im Verzeichnis modeler\<Architektur>, wobei <Architektur> für 32bit oder 64bit steht.

Beispiel für die Befehlszeile
Nachfolgend finden Sie eine Befehlszeile zur automatischen Übertragung einer Produktinstallation. Geben
Sie den gesamten Text in einer einzigen Zeile ein.
MsiExec.exe /i "modelerclient.msi" /qn /L*v logfile.txt
INSTALLDIR="C:\Programme\IBM\SPSS\Modeler\18.1.1" LICENSETYPE="Network" LSHOST="mylicserver"

Automatisches Übertragen der Installation mithilfe von SMS
Die grundlegenden Schritte für die Verwendung von Systems Management Servers (SMS) für die automa-
tische Übertragung (Push) von IBM SPSS Modeler sind folgende:
1. Extrahieren Sie den Inhalt des heruntergeladenen eImage und kopieren Sie das entsprechende Unter-

verzeichnis des Verzeichnis modeler\<Architektur> in ein Verzeichnis auf Ihrem Netzcomputer.
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2. Bearbeiten Sie die PDF-Datei im kopierten Verzeichnis. Bearbeiten Sie mithilfe eines Texteditors den
Wert von "CommandLine", indem Sie die entsprechenden Eigenschaften hinzufügen. Eine Liste der
verfügbaren Eigenschaften finden Sie in „Eigenschaften für automatisch übertragene Installationen”
auf Seite 9. Stellen Sie sicher, dass Sie die richtige MSI-Datei in der Befehlszeile angeben.

3. Erstellen Sie ein Paket aus der PDF-Datei und verteilen Sie das Paket an die Desktop-Computer der
Endbenutzer.

Verwenden der Gruppenrichtlinie oder einer ähnlichen Technologie zur automati-
schen Übertragung der Installation
1. Extrahieren Sie den Inhalt des heruntergeladenen eImage und kopieren Sie das entsprechende Unter-

verzeichnis des Verzeichnis modeler\<Architektur> in ein Verzeichnis auf Ihrem Netzcomputer.
2. Mit einer Anwendung wie ORCA können Sie die Eigenschaftstabelle in der entsprechenden Datei un-

ter dem kopierten Ordner bearbeiten. ORCA ist Teil des Windows 2003 Server SDK, das Sie unter
http://www.microsoft.com/downloads finden, indem Sie nach dem SDK suchen. Eine Liste der Ei-
genschaften, die in die Eigenschaftstabelle aufgenommen werden können, finden Sie in „Eigenschaften
für automatisch übertragene Installationen” auf Seite 9. Achten Sie darauf, dass Sie die richtige MSI-
Datei verwenden.

3. Erstellen Sie ein Paket aus der bearbeiteten Datei und verteilen Sie das Paket an die Desktop-Compu-
ter der Endbenutzer.

Automatische Übertragung einer Deinstallation
Hinweis: Wenn Sie den Deinstallationsbefehl automatisch übertragen, gehen die Anpassungen der Endbe-
nutzer verloren. Wenn bestimmte Benutzer ihre Anpassungen benötigen, können Sie diese aus der Vertei-
lung ausschließen und sie bitten, das Produkt manuell zu installieren.

Wenn Sie eine Installation einer neueren Version von IBM SPSS Modeler automatisch übertragen, sollten
Sie gegebenenfalls zuerst eine Deinstallation durchführen. Sie können diese im Hintergrund durchführen
lassen, indem Sie den folgenden Befehl durch einen Push-Vorgang automatisch übertragen. Geben Sie den
gesamten Text in einer einzigen Zeile ein.
MsiExec.exe /X{} /qn /L*v Protokolldatei.txt
ALLUSERS=1 REMOVE="ALL"

Den Produktcode für eine bestimmte Version finden Sie in der Datei setup.ini in den Installationsordnern
der betreffenden Version.

Verwalten der Lizenz für gleichzeitig angemeldete Benutzer
Der Lizenzmanager verwaltet die Lizenz für gleichzeitig angemeldete Benutzer. Mithilfe der Anwendung
WlmAdmin, die die Hauptbenutzerschnittstelle für den Lizenzmanageradministrator ist, können Sie den
Lizenzmanager verwalten und Informationen zu den verwalteten Lizenzen für gleichzeitig angemeldete
Benutzer anzeigen. Wenn Sie einen Lizenzmanager auf einem Nicht-Windows-System oder einem Remo-
te-Windows-System verwalten, installieren Sie den Lizenzmanageradministrator auf einem separaten Win-
dows-System. Weitere Informationen finden Sie in „Installieren des Lizenzmanageradministrators” auf
Seite 4.

Anmerkung: Weitere Informationen zur Administration finden Sie in der SafeNet-Dokumentation, die
zusammen mit dem Lizenzmanageradministrator installiert wird. Diese Dokumentation befindet sich im
Verzeichnis help\Content des Installationsverzeichnisses des Lizenzmanageradministrators (z. B.
C:\Programme (x86)\IBM\SPSS License Tools\9.7.0.0\help\Content).

Starten der Anwendung WlmAdmin
Wählen Sie im Windows-Startmenü Folgendes aus:

[Alle] Programme > IBM > SPSS License Tools > <Version> > Sentinel RMS Server Administration
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Hinzufügen eines Servers
Bevor Sie einen Lizenzmanager verwalten können, müssen Sie in der Anwendung WlmAdmin einen Ser-
ver dafür hinzufügen. Sie haben zwei Optionen, um den Server hinzuzufügen.

Manuelles Hinzufügen eines Servers
1. Wählen Sie in den Menüs der Anwendung WlmAdmin Folgendes aus:

Edit > Defined Server List

2. Geben Sie in das Dialogfeld "Defined Server List" den Namen oder die IP-Adresse des Servers ein, auf
dem der Lizenzmanager läuft.

3. Klicken Sie auf Add.
4. Klicken Sie auf OK.

Der Server wird jetzt in den Listen der Server im linken Fensterbereich der Anwendung WlmAdmin an-
gezeigt.

Anzeigen einer Liste der Server im Teilnetz
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben Subnet

Servers.

Eine Liste von Servern für Lizenzmanager in Ihrem Teilnetz wird angezeigt. Wenn Sie einen bestimmten
Server mit diesem Verfahren nicht finden, fügen Sie ihn wie oben beschrieben manuell hinzu.

Abrufen von Protokollinformationen
Wenn Endbenutzer beim Abrufen von Lizenzen Schwierigkeiten haben, enthalten die Protokolldateien
möglicherweise hilfreiche Informationen. Sie können die Umgebungsvariable LSERVOPTS sowie die Optio-
nen -f <Traceprotokolldatei> und -l <Nutzungsprotokolldatei> verwenden, um anzugeben, dass Pro-
tokolldateien erstellt werden sollen. Weitere Informationen zu dieser Umgebungsvariablen und den zuge-
hörigen Optionen finden Sie in der SafeNet-Dokumentation im Verzeichnis Content des
Installationsverzeichnisses des Lizenzmanageradministrators.

Anzeigen der Details zu einer Lizenz
Sie können Details zu Lizenzen anzeigen, die Sie entweder manuell oder über den Lizenzierungsassisten-
ten hinzugefügt haben.
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben dem Li-

zenzmanagerserver, um die Lizenz(en) anzuzeigen.
2. Klicken Sie auf den Namen der Lizenz. Im rechten Fensterbereich werden Details zu der Lizenz ange-

zeigt. Die Lizenzen werden mithilfe von Codes identifiziert. Der erste Teil des Codes verweist auf die
Funktion. Der zweite Teil verweist auf die Version.

Anzeigen der mit den Funktionscodes verknüpften Namen
1. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-

nistrators.
2. Geben Sie lmshowlic <Server> (Windows) oder ./lmshowlic <Server> (andere Betriebssysteme) ein.

Dabei stellt <Server> den Namen oder die IP-Adresse des Servers dar, auf dem der Lizenzmanager
ausgeführt wird.

In der Ausgabe werden alle Funktionen nach Produkt und Version in Gruppen geordnet aufgeführt, die
auf dem Server verfügbar sind.
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Einrichten von redundanten Lizenzservern
Sie können mehrere redundante Lizenzserver einrichten, die dieselben Benutzer unterstützen. Mit redun-
danten Servern können Sie Unterbrechungen verhindern, die durch den Absturz eines Servers bedingt
sind. Im Falle eines Serverabsturzes kann ein anderer redundanter Server die Lizenzverwaltung überneh-
men.

Zum Aktivieren der Redundanzfunktion benötigen Sie wie in den folgenden Schritten beschrieben einen
speziellen Lizenzcode. Wenden Sie sich telefonisch oder per E-Mail an den IBM Support, wenn Sie Unter-
stützung beim Erstellen eines redundanten Lizenzschlüssels benötigen oder andere Lizenzierungsproble-
me auftreten. Sie finden die Kontaktdaten unter http://www.ibm.com/planetwide/de.

Es muss eine ungerade Anzahl von Servern (mindestens drei) vorhanden sein und die Mehrzahl der Ser-
ver muss jeweils gleichzeitig ausgeführt werden. Wenn zum Beispiel drei redundante Lizenzserver exis-
tieren, müssen von diesen zwei ausgeführt werden.

Vorbereiten der einzelnen redundanten Lizenzserver
1. Installieren Sie den Lizenzmanager. Weitere Informationen finden Sie in „Installieren von Concurrent

License Manager” auf Seite 2.
2. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
3. Rufen Sie den Sperrcode für die einzelnen Server-Computer ab. Geben Sie an der Eingabeaufforde-

rung echoid (Windows) bzw. ./echoid (anderes Betriebssystem) ein.
4. Notieren Sie den Sperrcode. Sie benötigen den Sperrcode für die nächsten Schritte.
5. Wiederholen Sie diese Schritte für jeden redundanten Lizenzserver.

Aktivieren der redundanten Lizenzen
1. Rufen Sie das IBM SPSS License Key Center (https://spss.subscribenet.com/control/ibmp/login) auf.
2. Erstellen Sie einen Autorisierungscode für den gleichzeitigen Zugriff durch mehrere Nutzer.
3. Nach der Erstellung des Autorisierungscodes für den gleichzeitigen Zugriff durch mehrere Nutzer kli-

cken Sie auf den Code und blättern nach unten, bis Sie die Felder für den Sperrcode sehen. Sie kön-
nen dem Lizenzschlüssel jetzt mehrere Sperrcodes hinzufügen.

4. Geben Sie die in den vorherigen Schritten erstellten Sperrcodes in die entsprechenden Felder ein.
5. Klicken Sie auf Submit.

Einrichten eines Pools mit redundanten Lizenzservern
1. Wenn auf einem oder mehreren redundanten Lizenzservern ein Lizenzmanager ausgeführt wird, be-

enden Sie diesen auf jedem betroffenen Computer.
2. Wählen Sie in den Menüs der Anwendung WlmAdmin Folgendes aus:

Edit > Redundant License File

Dadurch wird die Anwendung WrlfTool geöffnet.
3. Wählen Sie in den Menüs der Anwendung WrlfTool Folgendes aus:

File > New

4. Klicken Sie für jeden redundanten Lizenzserver auf Add, um jeweils den Hostnamen und die IP-Ad-
resse anzugeben.

5. Ordnen Sie die redundanten Lizenzserver in der Reihenfolge an, in der sie verwendet werden sollen.
Der erste Server in der Liste ist der primäre Server.

6. Klicken Sie auf Add License, um die Lizenzen hinzuzufügen, die Sie vom Kundendienst oder Ihrer
lokalen Niederlassung erhalten haben. Achten Sie bei mehreren Lizenzen darauf, dass Sie auch wirk-
lich alle hinzugefügt haben.

7. Klicken Sie auf OK.
8. Klicken Sie abschließend auf Done.
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Speichern der redundanten Lizenzdatei
1. Wählen Sie in den Menüs der Anwendung WrlfTool Folgendes aus:

File > Save As

2. Speichern Sie die redundante Lizenzdatei (lservrlf) an einer leicht zugänglichen Position. In den nächs-
ten Schritten müssen Sie die Datei kopieren.

Konfigurieren der redundanten Lizenzserver
1. Kopieren Sie die redundante Lizenzdatei (lservrlf) unter Windows in den Unterordner winnt des Instal-

lationsverzeichnisses des Lizenzmanagers. Wenn Sie die Standardposition akzeptiert haben, prüfen Sie
den Ordner C:\Programme(x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager. Auf
anderen Betriebssystemen kopieren Sie die Datei direkt in das Installationsverzeichnis des Lizenzma-
nagers. Es müssen mindestens drei redundante Lizenzserver vorhanden sein.

2. Starten Sie auf allen redundanten Lizenzservern den Lizenzmanager.

Konfigurieren des Computers des Endbenutzers

Wenn ein Endbenutzer das Produkt installiert, gibt der Benutzer alle redundanten Server an. Die Namen
oder IP-Adressen der Server werden dabei durch Tilden getrennt (z. B. Server1~Server2~Server3). Das
Setup-Programm fügt dann dem Computer des Endbenutzers die erforderlichen Konfigurationsinformati-
onen hinzu. Wenn das Produkt bereits auf den Computern installiert ist, können Sie die folgenden Schrit-
te ausführen, um die Konfigurationsinformationen hinzuzufügen. Sie können auch zunächst eine Deins-
tallation und anschließend eine neue Installation übertragen, bei der alle Server festgelegt sind.
Informationen zum automatischen Übertragen von Installationen finden Sie in „Übertragen einer Installa-
tion auf Windows-Computer” auf Seite 8.
1. Öffnen Sie die Datei spssprod.inf in einem Texteditor. Unter Windows befindet sich diese Datei auf

dem Desktop-Computer im Installationsverzeichnis des Produkts.
2. Ändern Sie den Wert von DAEMONHOST in durch Tilden (~) getrennte Servernamen oder IP-Adressen.

Beispiel:
DAEMONHOST=Server1~Server2~Server3

3. Speichern Sie spssprod.inf.

Konfigurieren von Pendlerlizenzen
Mit Pendlerlizenzen können Endbenutzer Lizenzen aus dem Lizenzmanager auschecken, sodass sie diese
Lizenzen verwenden können, auch wenn sie nicht mit dem Netz verbunden sind. Pendlerlizenzen sind
standardmäßig aktiviert. Anweisungen für das Auschecken der Pendlerlizenz finden sich in den Installati-
onshinweisen für Endbenutzer.

Sie können den Prozentsatz der Lizenzen auf dem Lizenzmanagerserver beschränken, die für den mobi-
len Zugriff aktiviert werden. Es empfiehlt sich, die Anzahl der Pendlerlizenzen zu beschränken. Damit
wird verhindert, dass sich alle verfügbaren Lizenzen im mobilen Einsatz befinden. Wenn der angegebene
Prozentsatz an Lizenzen von mobilen Anwendern aufgebraucht wurde, stehen keine weiteren Lizenzen
zur Verfügung, bis die mobilen Lizenzen ablaufen oder wieder eingecheckt werden. Sie können außerdem
die Dauer festlegen, für die mobile Lizenzen ausgecheckt werden können. In der Standardeinstellung be-
trägt die maximale Dauer 3 Tage.

Wichtig: Wenn Sie redundante Lizenzserver mit Pendlerlizenzen verwenden, gestattet nur der primäre
Lizenzserver den Benutzern, Pendlerlizenzen aus- und einzuchecken. Bei einem Ausfall des primären Li-
zenzservers können die Benutzer keine Lizenzen ein- und auschecken.

Festlegen des Prozentsatzes der verfügbaren Pendlerlizenzen
1. Erstellen Sie auf dem Lizenzmanagerserver eine Umgebungsvariable mit dem Namen LSERVOPTS. Die-

se Variable wird unter Windows während der Lizenzmanagerinstallation erstellt, sodass Sie diesen
Schritt nur für die anderen Betriebssysteme durchführen müssen.
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2. Ändern Sie den Wert der Umgebungsvariablen LSERVOPTS, indem Sie -com <Prozentsatz> aufnehmen.
Dabei stellt <Prozentsatz> einen numerischen Wert zwischen 0 und 100 dar, der den Prozentsatz an
Lizenzen angibt, die für den mobilen Zugriff verfügbar sind. Mit der Angabe 0 stehen keine Lizenzen
für den mobilen Zugriff zur Verfügung. Dieser Schalter ist unter Windows standardmäßig enthalten
und auf 0 festgelegt.

3. Starten Sie den Computer neu, auf dem der Lizenzmanager ausgeführt wird.

Festlegen der maximalen Zeitdauer für Pendlerlizenzen

Die maximale Zeitdauer, für die die Endbenutzer eine Pendlerlizenz auschecken können, wird durch die
Einstellung CommuterMaxLife in der Datei spssprod.inf auf dem Desktop-Computer angegeben. Unter Win-
dows befindet sich diese Datei auf dem Desktop-Computer im Installationsverzeichnis des Produkts. Öff-
nen Sie die Datei spssprod.inf und suchen Sie nach CommuterMaxLife. Setzen Sie den Wert dieser Option
auf die maximale Anzahl von Tagen, für die die Endbenutzer eine Pendlerlizenz auschecken können. Der
Wert sollte eine Zahl zwischen 1 und 30 sein. Sie können diesen Wert auch festlegen, wenn Sie die Instal-
lation automatisch übertragen. Weitere Informationen finden Sie in „Übertragen einer Installation auf
Windows-Computer” auf Seite 8.

Hinweis: Diese Funktion arbeitet mit einer Datums-, nicht mit einer Zeitangabe. Wenn Sie zum Beispiel
die Option CommuterMaxLife auf einen Tag setzen und dann eine Lizenz um 9:00 Uhr auschecken, wird
diese Lizenz nicht vor Mitternacht des Folgetages wieder eingecheckt. Auch wenn also CommuterMaxLife
auf einen Tag eingestellt ist, behält der Benutzer die Lizenz tatsächlich 39 Stunden lang.

Abrufen einer Liste der ausgecheckten Lizenzen in der Befehlszeile

Sie können ermitteln, welche Benutzer Lizenzen ausgecheckt haben.
1. Wechseln Sie über eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-

nistrators.
2. Geben Sie Ismon<Server> (Windows) oder ./lsmon <Server> (andere Betriebssysteme) ein. Dabei stellt

<Server> den Namen oder die IP-Adresse des Servers dar, auf dem der Lizenzmanager ausgeführt
wird. Sie können den Namen des Lizenzservers auslassen, wenn Sie nur die ausgecheckten Lizenzen
für den Server "localhost" anzeigen möchten.

Abrufen einer Liste der ausgecheckten Lizenzen in der Anwendung WlmAdmin

Sie können ausgecheckte Lizenzen auch in der Anwendung WlmAdmin anzeigen:
1. Klicken Sie im linken Fensterbereich der Anwendung WlmAdmin auf das Zeichen + neben dem Li-

zenzmanagerserver.
2. Klicken Sie auf das Zeichen + neben Clients. Die Clients, die die Lizenz für gleichzeitig angemeldete

Benutzer nutzen, werden aufgelistet. Wenn keine Clients aufgelistet werden, verwendet kein Benutzer
die Lizenz für gleichzeitig angemeldete Benutzer.

3. Wählen Sie einen bestimmten Client aus, um anzuzeigen, ob der Client eine Lizenz ausgecheckt hat.
Überprüfen Sie nach der Auswahl den Bereich "Detaillierte Informationen" im rechten Fensterbereich.

Konfigurieren von Lizenzreservierungen
Sie können eine Reservierungsdatei erstellen, in der angegeben wird, wie viele Lizenzen für bestimmte
Benutzer oder Benutzergruppen reserviert werden. Die Benutzer werden durch Netz-IDs oder Compu-
ternamen (nicht durch IP-Adressen) identifiziert. Sie können zum Beispiel eine Reservierungsdatei einrich-
ten, mit der die Lizenz für eine Gruppe von Hauptbenutzern reserviert wird. Für diese Benutzer werden
die Lizenzen immer verfügbar sein. Mithilfe der Reservierungen können Sie auch verhindern, dass be-
stimmte Benutzer einen Zugriff auf die Lizenz bekommen.
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Erstellen einer neuen Reservierungsdatei
1. Wählen Sie in den Menüs der Anwendung WlmAdmin Folgendes aus:

Edit > Reservation File

Dadurch wird die Anwendung Wlsgrmgr geöffnet.
2. Wählen Sie in den Menüs der Anwendung Wlsgrmgr Folgendes aus: File > New.

Hinzufügen von Lizenzen und Benutzer zur Reservierungsdatei
1. Wählen Sie in den Menüs der Anwendung Wlsgrmgr Folgendes aus:

Feature > Add

2. Klicken Sie im ersten Bildschirm des Assistenten auf Next.
3. Geben Sie den Funktionscode für die entsprechende Lizenz an, die Sie reservieren möchten. Informati-

onen zum Abrufen der Funktionscodes für die entsprechenden Lizenzen finden Sie in „Anzeigen der
Details zu einer Lizenz” auf Seite 11. Legen Sie außerdem eine bestimmte Version fest. Geben Sie die
Version hierbei so ein, wie sie in der Anwendung WlAdmin angezeigt wird (z. B. 160). Die Version ist
nicht optional. Ignorieren Sie die Steuerelemente für "Capacity", weil Lizenzen dieses Typs nicht un-
terstützt werden.

4. Klicken Sie auf Next.
5. Geben Sie für die Gruppe von Benutzern einen Namen an. Der Name ist willkürlich, er sollte jedoch

aussagekräftig sein (z. B. Vertrieb).
6. Geben Sie die Anzahl der Lizenzen an, die für diese Gruppe reserviert werden sollen. Die Gruppen-

mitglieder können auf alle Lizenzen zugreifen. Die Anzahl von Lizenzen, die Sie angeben, steht je-
doch nicht mehr für die Benutzer zur Verfügung, die nicht Mitglied dieser Gruppe sind. Dies bedeu-
tet: Wenn Sie 5 von 10 Lizenzen reservieren, können Mitglieder dieser Gruppe über 10 Lizenzen
verfügen, während den anderen Benutzern nur 5 Lizenzen zur Verfügung stehen.

7. Klicken Sie im Fenster "Members" auf Add, um einen der Gruppe zugehörigen Benutzer oder Compu-
ternamen (keine IP-Adressen verwenden) anzugeben. Benutzer und Computer, die der Gruppe ange-
hören, können die reservierten Lizenzen verwenden. Benutzer und Computer, die der Gruppe nicht
angehören, können nicht auf die reservierten Lizenzen zugreifen. Geben Sie so viele Benutzer und
Systeme wie erforderlich an. Beachten Sie, dass sich die Gruppen gegenseitig ausschließen müssen.
Daher können verschiedenen Gruppen für dieselbe Lizenz nicht dieselben Benutzer oder Computer
enthalten.

8. Klicken Sie auf Finish, wenn Sie der Gruppe alle Benutzer hinzugefügt haben.
9. Fügen Sie nach Bedarf weitere Gruppen oder Lizenzen hinzu. Sie können Lizenzen und Gruppen

auch ändern oder löschen, indem Sie auf diese mit der rechten Maustaste klicken und die Option Pro-
perties auswählen.

Speichern der Reservierungsdatei
1. Wählen Sie in den Menüs Folgendes aus, wenn Sie die Reservierungsdatei fertiggestellt haben:

File > Save As

2. Speichern Sie die Datei an einer leicht zugänglichen Position. Im nächsten Schritt müssen Sie die Da-
tei kopieren.

3. Um die Einstellung zu aktivieren, dass der Lizenzserver die Datei lsreserv beim Start automatisch fin-
det, kopieren Sie die Datei unter Windows in den Unterordner winnt im Installationsverzeichnis des
Lizenzmanagers. Wenn Sie die Standardposition akzeptiert haben, prüfen Sie den Ordner
C:\Programme(x86)\Common Files\SafeNet Sentinel\Sentinel RMS License Manager. Auf anderen Be-
triebssystemen kopieren Sie die Datei direkt in das Installationsverzeichnis des Lizenzmanagers.

4. Wenn Sie allen redundanten Servern dieselben Reservierungen zuweisen möchten, kopieren Sie die
Reservierungsdatei (lsreserv) auf jeden Server.

5. Starten Sie abschließend jeden Lizenzmanager neu.
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Starten und Stoppen des Lizenzmanagers
Die Methode zum Starten des Lizenzmanagers hängt von Ihrem Betriebssystem ab.

Windows

Auf Windows-Computern wird der Lizenzmanager als Systemdienst ausgeführt. Der Dienst wird stan-
dardmäßig automatisch gestartet. Falls Sie ihn dennoch einmal manuell starten müssen, gehen Sie wie
folgt vor:
1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.
2. Doppelklicken Sie auf Dienste.
3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
4. Klicken Sie mit der rechten Maustaste auf den Dienst und wählen Sie die Option Starten oder Been-

den aus.

Andere Betriebssysteme

Auf anderen Betriebssystemen wird der Lizenzmanager als Dämonprozess ausgeführt. Führen Sie zum
manuellen Starten die folgenden Schritte aus. Sie können den Lizenzmanager auch zum automatischen
Starten konfigurieren (Anweisungen folgen).
1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
2. Starten. Geben Sie als Root an der Eingabeaufforderung ./lserv & ein und drücken Sie die Eingabe-

taste.
3. Beenden. Geben Sie als Root ./lsrvdown <Hostname> an der Eingabeaufforderung ein, wobei <Hostna-

me> der Netzname des Computers ist, auf dem der Lizenzmanager ausgeführt wird. Drücken Sie an-
schließend die Eingabetaste.

Konfigurieren des Lizenzmanagers für den automatischen Start
Windows
1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.
2. Doppelklicken Sie auf Dienste.
3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
4. Klicken Sie mit der rechten Maustaste auf den Dienst und wählen Sie die Option Eigenschaften aus.
5. Legen Sie als "Starttyp" Automatisch fest.
6. Klicken Sie auf OK.

Andere Betriebssysteme
1. Fügen Sie einer der Startdateien des Betriebssystems den Eintrag ./lserv & hinzu.

Deinstallieren des Lizenzmanagers
Windows
1. Wählen Sie im Windows-Startmenü Folgendes aus:

Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Programme hinzufügen/entfernen.
3. Wählen Sie Sentinel RMS License Manager und klicken Sie anschließend auf Entfernen.
4. Klicken Sie auf Ja, wenn Sie gefragt werden, ob der Lizenzmanager entfernt werden soll.

Andere Betriebssysteme
1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
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2. Beenden Sie den Lizenzmanager, indem Sie als Root an der Eingabeaufforderung ./lsrvdown
<Hostname> eingeben, wobei <Hostname> der Netzname des Computers ist, auf dem der Lizenzmana-
ger ausgeführt wird. Drücken Sie anschließend die Eingabetaste.

3. Löschen Sie das Installationsverzeichnis des Lizenzmanagers.

Deinstallieren des Lizenzmanageradministrators
1. Wählen Sie im Windows-Startmenü Folgendes aus:

Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Programme hinzufügen/entfernen.
3. Wählen Sie License Tools aus und klicken Sie anschließend auf Entfernen.
4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, die parallelen Lizenzierungstools zu entfernen.

Fehlerbehebung bei Problemen mit den Desktop-Computern
Gehen Sie folgendermaßen vor, wenn die Desktop-Computer der Endbenutzer den Lizenzmanager nicht
finden können:
1. Führen Sie lswhere aus, um zu überprüfen, ob der Desktop-Computer den Netzcomputer finden

kann, auf dem der Lizenzmanager ausgeführt wird. Weitere Informationen finden Sie in „Ausführen
von "Iswhere"”.

2. Vergewissern Sie sich, dass der Lizenzmanagerservice auf dem Netzcomputer ausgeführt wird.
3. Überprüfen Sie die entsprechende Datei spssprod.inf. Unter Windows befindet sich diese Datei auf dem

Desktop-Computer im Installationsverzeichnis des Produkts. Öffnen Sie die Datei spssprod.inf und ver-
gewissern Sie sich, dass für DAEMONHOST der richtige Name bzw. die richtige IP-Adresse des Computers
festgelegt ist, auf dem der Lizenzmanager ausgeführt wird. Wenn Sie redundante Server einsetzen,
müssen alle Namen bzw. IP-Adressen angegeben werden. Die einzelnen Namen werden durch eine
Tilde (~) getrennt. Wenn es sich beispielsweise bei den Lizenzmanagercomputern um SERVER1, SER-
VER2 und SERVER3 handelt, wird DAEMONHOST auf SERVER1~SERVER2~SERVER3 gesetzt.

Ausführen von "Iswhere"
lswhere kann über den Desktop-Computer eines Endbenutzers ausgeführt werden, um zu ermitteln, auf
welchem Computer der Concurrent License Manager ausgeführt wird.
1. Wechseln Sie über die Eingabeaufforderung in das Installationsverzeichnis von IBM SPSS Modeler.
2. Geben Sie lswhere ein.
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